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General Style
All ASABE peer‐reviewed journals use the same editorial style, but they differ in scope and
content. The best way to familiarize yourself with the general style of an ASABE publication
is to review a recent issue of the journal to which you intend to submit your manuscript.
With a few exceptions, ASABE conforms to The Chicago Manual of Style. If you have
questions about style, usage, technical terms, or reference citations, feel free to ask us for
assistance. Contact Glenn Laing at 269‐429‐0300, ext. 314, or e‐mail: laing@asabe.org.
Words and Numbers

In general, use words for numbers one through nine, and use digits for 10 and over. For a
series of numbers, any of which are over 10, use all digits. For example:
There were nine compounds used to create the substance.
The component consisted of 231 parts.
The substance contained 2 parts magnesium, 12 parts copper, and 8 parts lead.
When two numbers occur as adjacent adjectives, spell out the first one:
There were thirty 12 mm holes in the first section.
When a number begins a sentence, spell it out or rewrite the sentence:
Fifty samples were prepared.
We prepared 50 samples.
When you are reporting a number, the number of significant digits must be commensurate
with the precision of your experimental method. If the quantity must be converted to SI
units, multiply the quantity by the exact conversion factor and then round to the
appropriate number of significant digits.
Units of Measurement

Express all units of measure in SI (metric) units. You may include inch/pound units in
parentheses in special instances, such as when quoting research data or specifications that
were originally supplied in non‐metric units. For a further explanation of units and
conversions, refer to ASAE Standard EP285.7: "Use of Metric Units."
To express a unit of measurement, space between the number and the unit:
5g
20 ha
except for percentages and degrees:
37%
27°C
In a series of measurements, indicate the unit at the end:
3, 6, and 8 cm.
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except for percentages and degrees:
2°C to 10°C
Precede fractional decimal values with a zero:
0.0125 (not .0125).
A comma is not necessary for numbers consisting of four digits:
1000 kg
Express derived units in exponent form:
12 kg m ‐2
32 MJ m ‐2 d‐1
with spaces between the elements of the derived unit.
When only two units of measurement are combined, the solidus ( / ) may be used:
9 Mg/m 3 or 9 Mg m‐3
but avoid using both styles in the same manuscript.
Time and Dates

There are two international methods of reporting time:
In the first method, the day is divided into two 12‐hour periods. The first period is
numbered 1:00 a.m. through 12:00 a.m. (noon), and the second period is numbered 1:00
p.m. through 12:00 p.m. (midnight).
In the second method, often called military time, the hours are numbered consecutively 1
through 24. The day begins at midnight (0000 h), and the last minute of the day ends at
2359 h:
4:00 a.m. = 0400 h
12:00 noon = 1200 h
10:43 p.m. = 2243 h
Note that the notation "2400 h on 14 January" is the same time as "0000 h on 15 January."
Occasionally, the 12‐hour a.m./p.m. time system can lead to confusion, as the term "12:00
p.m." could be read as noon or midnight. In addition, the term "midnight of 22 November"
is ambiguous; it can either refer to midnight of 21‐22 November or midnight of 22‐23
November. To avoid confusion, use of 24‐hour military time is recommended.
Write all dates in day‐month‐year format, with no punctuation and with names, rather than
numbers, for the months:
12 January 2002
29 April to 17 May
4 to 16 August
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In tables, the names of months may be abbreviated to save space.
Abbreviations

In general, spell out abbreviations that that might be unfamiliar to the ASABE audience.
Such abbreviations only need to be spelled out at their first occurrence in the text. Always
abbreviate government agencies and organizations that are well known to the ASABE
audience, such as USDA.
Spell out the scientific name of an organism at its first occurrence in the text. After the first
occurrence, use the first letter of the genus and spell out the specific epithet.
If you abbreviate the names of months in tables and figures, use the following forms:
Jan., Feb., Mar., Apr., Aug., Sept., Oct., Nov., Dec.
Form plurals for abbreviations without an apostrophe:
PCs, CVs, PhDs
Omit periods after abbreviated units (except "in." for inch):
5 m, 30 cm, 40 ft
Abbreviate units only after a numeric value:
24 h
Several hours later
Units of Measurement and Technical Terms

The following abbreviations are for units of measurement and technical terms that are
widely used in material published by ASABE:
alternating current AC

kilo‐ k (as in kV)

ampere A

liter L

bushel bu

micro‐ µ (as in µV)

coefficient of variation CV

milli‐ m (as in mL)

cultivar cv. (for example: Syringa vulgaris
cv. Mont Blanc)

minute min

direct current DC
dry basis d.b.
hectare ha
hour h
inch in.
inside diameter i.d.

moisture content MC
outside diameter o.d.
pound lb
second s
volt V
watt W
wet basis w.b.

joule J
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Abbreviations in References

Use conventional abbreviations (not postal abbreviations) for names of states and
territories.
Avoid abbreviating words or titles that might be unfamiliar to the ASABE audience.
Do not abbreviate titles of articles, books, or dissertations. For journal titles:
Drop all minor words from journal titles (such as articles, prepositions, and conjunctions)
unless their omission could cause confusion.
Abbreviate similar words consistently.
Use the following abbreviations for the titles of journals and proceedings that appear in
bibliographic references:
Agricultural Agric.

Experiment Exp.

Medicine Med.

Agriculture Agric.

Experimental Exp.

National Natl.

Agronomy Agron.

Extension Ext.

Occupational Occup.

Annals Ann.

Federation Fed.

Proceedings Proc.

Annual Ann.

Fundamentals Fundam.

Processing Process.

Applications Applic.

Goverment Gov.

Product Prod.

Association Assoc.

Horticulture Hort.

Production Prod.

Biology Biol.

Industrial Ind.

Publication Publ.

Chemical Chem.

Industry Ind.

Publishing Publ.

Chemistry Chem.

Institute Inst.

Research Res.

Communications Comm.

International Intl.

Resource Resource

Conference Conf.

Irrigation Irrig.

Review Rev.

Conservation Conserv.

Journal J.

Cooperative Coop.

Journal of J.

Science Sci. (except the
journal Science)

Division Div.

Literature Lit.

Society Soc.

Ecological Ecol.

Management Mgmt.

Statistics Stat.

Engineering Eng.

Mathematics Math.

Symposium Symp.

Engineers Eng.

Mechanical Mech.

System Syst.

Environmental Environ.

Mechanics Mech.

Technical Tech.

States and Territories

Use the full name (Alabama) for affiliations in the author notes and in the body of the
article, for example: "The study was conducted on an experimental farm in Alabama."
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Use conventional abbreviations (Ala.) in parenthetical notes (such as for product
manufacturers) and in the references.
Use 2‐letter postal abbreviations (AL) only in mailing addresses, such as for the
corresponding author in the author notes.
Full name Conventional Postal

Alabama Ala. AL

Kansas Kansas KS

Oklahoma Okla. OK

Alaska Alaska AK

Kentucky Ky. KY

Oregon Oregon OR

American Samoa Amer.
Samoa

Louisiana La. LA

Pennsylvania Pa. PA

Maine Maine ME

Puerto Rico P.R.

Maryland Md. MD

Rhode Island R.I. RI

Massachusetts Mass. MA

South Carolina S.C. SC

Michigan Mich. MI

South Dakota S.D. SD

Minnesota Minn. MN

Tennessee Tenn. TN

Mississippi Miss. MS

Texas Texas TX

Missouri Mo. MO

United States U.S.

Montana Mont. MT

Utah Utah UT

Nebraska Neb. NE

Vermont Vt. VT

Nevada Nev. NV

Virgin Islands V.I.

New Hampshire N.H. NH

Virginia Va. VA

New Jersey N.J. NJ

Washington Wash. WA

New Mexico N.M. NM

West Virginia W.V. WV

New York N.Y. NY

Wisconsin Wisc. WI

North Carolina N.C. NC

Wyoming Wyo. WY

Arizona Ariz. AZ
Arkansas Ark. AR
California Cal. CA
Canal Zone C.Z.
Colorado Colo. CO
Connecticut Conn. CT
Delaware Del. DE
District of Columbia D.C.
DC
Florida Fla. FL
Georgia Ga. GA
Guam Guam
Hawaii Hi. HI
Idaho Idaho ID
Illinois Ill. IL
Indiana Ind. IN
Iowa Iowa IA

North Dakota N.D. ND
Ohio Ohio OH

Figures
ASAE applies the term "figure" to all types of illustration, including line drawings, graphs
and charts, photographs, computer screen captures, etc. Include figures to emphasize
points made in the text, not merely to illustrate tabular material graphically. Please observe
the following points:
•

Number figures consecutively in order of their citation in the text and refer to them
as figure 1, figure 2, etc. Abbreviate the word "figure" only in parentheses, i.e., (fig.
1).
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•
•
•
•

When appropriate, such as to define symbols, accompany figures with legends. Place
the legend either directly below the figure or within it.
Do not include excessive explanatory text in the figures. Place explanatory
information in the figure caption or in the manuscript text.
Supply a descriptive caption for each figure. The caption can be a sentence fragment
or up to two sentences long.
Do not include the caption in the electronic art. Instead, type the caption below the
electronic figure using the word processing program.

Graphs primarily show trends, so it is not necessary to show all the data points and co‐
ordinate rulings in most graphs. If a point represents the mean of a number of
observations, indicate the magnitude of the variability by a vertical line at each point. If
appropriate, use a legend to define line styles, to indicate if the variability is standard error
(SE) or standard deviation (SD), or to specify the number of observations or other
parameters.
Sample Figure and Caption

Use of Color

Online editions of ASAE journals and technical papers can use color, but print editions are
limited to gray‐scale representation of color. Therefore, choose colors that reproduce as
distinct gray values. Do not use yellow. Choose distinct line types (dashed, dotted, etc.) as
well.
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How to Insert Figures into a Document

Authors using Microsoft Word occasionally have problems with inserting figures and
having them stay in place. If a figure has white "handles" when you click on it, or if the
cursor displays arrows pointing in four directions when you pass over a figure, then that
figure will float in the manuscript. Such figures must be placed "in line with text" so that
they will stay where you want them, and so that the document will pass through our
production process.
There are three methods that can ensure that a figure remains in place:
1. The easiest method is to right click on the figure, select "Format Picture" or "Format
Object," select the "Layout" tab, and click on "In line with text" or uncheck the "Float
over text" box. If after this procedure the figure isn't exactly where you want it, cut and
paste it to the correct location. Notice that the white "handles" become black.
2. If, in the previous procedure, the figure does not allow you to select "In line with text,"
then cancel the dialog box. Cut the figure, pull down the "Edit" menu, select "Paste
Special....", and select "picture." After the picture has been pasted, right click on the
figure, select "Format Picture" or "Format Object," select the "Layout" tab, and click on
"In line with text." (Notice the white "handles" become black). If the figure isn't exactly
where you want it, cut and paste it into the correct location.
3. Finally, if the figure has a combination of white‐ and black‐handled elements, then we
may have to scan the figure from your paper printout. Many authors insert section
breaks before and after such figures to keep them relatively in place in the manuscript.
Regarding methods 1 and 2, be sure to select all of the elements of the figure. Some figures
are just one piece, but many figures have individual text boxes and line segments. It is
helpful to "group" all individual boxes. To do this:
1. Turn on the Drawing tools in Microsoft Word. To do this, right click on the gray menu
area (above the page area) and select drawing. The Drawing palette should appear on
the screen.
2. Select each element in the figure by clicking on it while holding down the shift key, or
select the white arrow on the Drawing palette and click and drag it across the figure to
select all the elements. If any elements are not selected, hold down the Shift key and
click on them.
3. Click on "Draw" in the Drawing palette, and select "Group." If the white handles are still
showing, you may proceed with method 1 above. If the white handles are not showing,
pass your cursor over the figure until the four arrows appear, click on the figure, and
proceed with method 1.
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Finally, do not crop the figure in Word to eliminate extraneous elements; the cropping will
not be retained as the figure moves through our production process. Instead, open the
figure and delete the unwanted elements.
Incorporating Figures into the Text

As explained in the preceding sections, insert each figure into your manuscript after the
paragraph that first mentions it. Every figure must be explicitly mentioned in the text of the
article.
References to figures in the text may use any of these forms:
Refer to figure 4
As shown in figure 4
(fig. 4)
Note that the word "figure" is not capitalized, except at the beginning of a sentence, and is
abbreviated only in parentheses.

Tables
Tables are used for reporting extensive numerical data in an organized manner. Tables
should be self‐explanatory. The data presented in tables should neither be duplicated in
figures nor reviewed extensively in the text, but each table must be introduced in the text.
Please observe the following points:
•
•
•
•

Number the tables consecutively and refer to them in the text as table 1, table 2, etc.
Do not include excessive text in the column headings. Place explanatory information
in the table caption, in the manuscript text, or in a footnote at the bottom of the
table.
Supply a descriptive caption for each table. The caption can be a sentence fragment
or up to two sentences long.
Use no more digits than the accuracy of the method justifies. Do not include columns
of data that can be easily calculated from other columns.
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Sample Table Caption

Footnotes in Tables

Assign footnotes to elements within a table in a left‐to‐right, top‐to‐bottom sequence.
· Use bracketed superscripted letters ([a], [b], [c], etc.) for explanatory footnotes within the
table (as in the sample table above).
· Use asterisks (*, **) to indicate statistical significance, and explain the significance in a
corresponding footnote.
· Use lowercase letters (a, b, c, etc.) to indicate statistical relationships among elements
within a table, and explain the relationships in a footnote.
Incorporating Tables into the Text

Insert each table into your manuscript after the paragraph that first mentions it. Every
table must be explicitly mentioned in the text. References in the text may use any of these
forms:
Refer to table 5
As listed in table 5
(table 4)
Note that the word "table" is not capitalized, except at the beginning of a sentence.

Equations
Do not derive or reproduce standard equations. Do not repeat previously published
derivations of recognized equations; rather, cite a reference to a source and refer to the
equation by its standard name. State only those assumptions and initial boundary
conditions needed to understand the development of the equation.
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For new equations, state all assumptions and initial boundary conditions and give sufficient
derivation for the reader to understand the development. Show only those mathematical
steps required for comprehension. Interpret the significance of the mathematics, and
indicate the accuracy and range of usefulness of the equations. Please observe the following
points:
· Equations do not have captions. Instead, number the equations consecutively and refer to
them in the text as equation 1, equation 2, etc. Supply the equation number, in parentheses,
to the right of the equation. Do not include the equation number within the equation editor
box.
· Define variables and supply SI units. If there are more than two such elements in an
equation, then list them individually after the equation (as in the sample equation).
Sample Equation and Equation Number

Incorporating Equations into the Text

Insert each equation into your manuscript at the point where you would like it to appear in
the published article. Equations are usually introduced by the preceding sentence followed
by a colon (see the sample equation above). When used in the text, the word "equation" is
not capitalized, except at the beginning of a sentence, and is abbreviated (eq.) only in
parentheses.

References
To cite a reference in the text, use the name‐year system. The specific form will vary
according to the construction of the sentence in which it occurs:
as described by Bowen (1994)
as described earlier (Bowen, 1994)
Bowen (1994) described this effect
For references with two authors, list both names in the citation:
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as described by Bowen and Roberts (1997)
as described earlier (Bowen and Roberts, 1997)
Bowen and Roberts (1997) described this effect
For references with three or more authors, use the form Bowen et al. (1998). Note that "et
al." is not italicized.
List all cited references at the end of the text in the References section. Arrange the list
alphabetically by the name of the first author; further arrange the list alphabetically by the
names of the second author, third author, etc., for jointly authored references or multiple‐
authored articles:
· List two or more references by the same author (or authors) chronologically from oldest
to most recent.
· Place single‐author references before jointly authored references in which the same
individual is the lead author.
· Place jointly authored references before multiple‐authored articles in which the same
individual is the lead author.
· Indicate two or more references by the same author(s) in the same year by adding letters
after the year of publication. For example: 1987a, 1987b.
Journal Article

References for journal articles list the author(s), the year of publication, the full title of the
article, the journal title, and the volume number, issue number (if any), and page range.
Anderson, G. T., C. V. Renard, L. M. Strein, and E. C. Cayo. 1998. A new technique for
rapid deployment of rollover protective structures. Applied Eng. in Agric. 23(2):
34‐42.
Renard, C., and T. Van Loon. 2002. Use of power equipment by youth in the Midwest:
1999‐2001. J. Agric. Safety and Health 7(3): 98‐105.
Book

Book references list the author(s), the year of publication, the full title, the edition if other
than the first, the place of publication, and the publisher. If you need to cite specific pages
of a book, list them in the parenthetical citation, for example: (Allen, 1988, pp. 67‐71).
Allen, J. S. 1988. Agricultural Engineering Applications. New York, N.Y.: John Wiley
and Sons.
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Coombs, T. R., and F. C. Watson. 1997. Computational Fluid Dynamics. 3rd ed.
Wageningen, The Netherlands: Elsevier Science.
Part of a Book

Identify a part of a book by chapter or section title and by page range. List the book editor if
different from the author. Note that ASAE Standards receive unique treatment.
ASAE Standards. 1989. S352.1: Moisture measurement ‐‐ Grain and seeds. St. Joseph,
Mich.: ASAE.
Havelock, T. F. 1995. Statistical methods. In Practical Programming Applications, 223‐
227. Holland, Mich.: Overstreet Technical Publications.
Bulletin or Report

Bulletins, reports, and other small, self‐contained documents often do not have named
authors. For the purpose of citing the document in your manuscript, use the name of the
publishing organization as the author, abbreviated if necessary. Do not use "Anonymous."
CDC. 2000. Infection vectors for E. coli and intervention strategies. CDC Reference No.
9923. Atlanta, Ga.: Centers for Disease Control and Prevention.
Jesperson, D. 1995. United States fruit and vegetable harvest projections: 1996. USDA‐
1007. Washington, D.C.: GPO.
Published Paper and Conference Proceedings

A paper published independently or as part of a proceedings compilation must list all
authors, the full title, the volume editors (if any), and the name and location of the
publisher or sponsoring organization. If the paper was published in the conference
proceedings, use
this format:
Cundiff, J. S., D. H. Vaughan, and D. J. Parrish. 1985. Pith separation procedure for
processing whole‐stalk sweet sorghum. In Proc. 5th Annual Solar and Biomass
Workshop, 133‐136. Ukiah, Cal.: Center for Solar Energy Research.
Note that it's not necessary to list the conference date and location. It's more important to
list the name and location of the publisher of the proceedings and/or the sponsor of the
conference, as this information will help an interested reader locate the paper.
Increasingly, conference proceedings, and other large documents, are published on CD‐
ROM. In such cases, use this format:
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Miller, F. R., and R. A. Creelman. 2001. Sorghum: A new fuel. In Proc. 12th International
Alternative Fuels Research Conf., CD‐ROM. H. D. Londen and W. Wilkinson, eds.
Warrendale, Pa.: SAE.
If the paper is not available in a proceedings document, use this format:
Anthony, W. S. 1998. Performance characteristics of cotton ginning machinery. ASAE
Paper No. 981010. St. Joseph, Mich.: ASAE.
Dissertation or Thesis

If available, include the Library of Congress or the Dissertation Abstracts number in
the reference.
Campbell, M. D. 1991. The lower limit of soil water potential for potato growth. PhD diss.
Pullman, Wash.: Washington State University, Department of Agricultural
Engineering.
Lawrence, D. J. 1992. Effect of tillage and crop rotation on soil nitrate and moisture. MS
thesis. Ames, Iowa: Iowa State University, Department of Soil Science.
Workman, S. R. 1990. Development and application of a preferential flow model. PhD
diss. Raleigh, N.C.: North Carolina State University, Department of Biological and
Agricultural Engineering.
Software

An author's name is rarely available for software products, so the reference is usually
alphabetized (and cited in the text) with a shortened version of the company name or
product name.
SAS. 1990. SAS User's Guide: Statistics. Ver. 6a. Cary, N.C.: SAS Institute, Inc.
SPSS. 2000. SigmaPlot for Windows. Ver. 3.2. Chicago, Ill.: SPSS, Inc.
Online Source

For online sources, list the author's name or an abbreviated form of the publisher's name,
the title of the specific section from which you have drawn information, the name of the
site, and the name of the publisher or sponsoring organization. Include the URL address
and the date on which you accessed the information.
USDA. 1999. Wheat Production in the Upper Plains: 1998‐1999. National Agricultural
Statistics Database. Washington, D.C.: USDA National Agricultural Statistics
Service. Available at: www.nass.usda.gov. Accessed 23 April 2000.
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MMWR. 2000. Morbidity and Mortality Weekly Report: 26 June 2000. Atlanta, Ga.:
Centers for Disease Control and Prevention. Available at: www.cdc.gov/mmwr.
NSC. 2001. Injury Facts Online. Itasca, Ill.: National Safety Council. Available at:
www.nsc.org. Accessed 17 December 2001.
Patent

Identify patents by the inventor's name, the year of issue, the full title, and the patent
number.
Moulton, R. K. 1992. Method for on‐site cleaning of contaminant filters in livestock
housing facilities. U.S. Patent No. 32455986.
Richarde, J. 1983. Process for protecting a fluid product and installations for the
realization of that process. French Patent No. 2513087 (in French).
Unpublished Material

Include references to personal communication in the text of your manuscript. Write such
references as parenthetical citations:
(C. Williams, personal communication, 23 November 1998)
It is not necessary to list personal communications in the References section because they
are not available to the reader.
Unpublished material can also include interviews, meeting minutes, mimeographed
reports, and raw data. As with personal communication, identify these references in the
text within parentheses. Include the source, the date, the location, and any other available
information that can establish the authenticity of the reference. For example:
(R. Creiss, unpublished data, 1999. Gainesville, Fla.: University of Florida)
(W. Chancellor, interview by author, Davis, Cal., 1 August 1995).
If you choose to list unpublished information in the References section of your manuscript,
then include a parenthetical citation in the text and use the following format in the
References section:
Williams, C. 1998. Personal communication. 23 November.
Creiss, R. 1999. Unpublished data. Gainesville, Fla.: University of Florida.
If you refer to an unpublished source more than once in the text, then you must list it in the
References section.
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